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1 ОСНОВНЫЕ СВЕДЕНИЯ О ТЕОРИИ  ФАЗЗИ-ЛОГИКИ  И 

ФАЗЗИ-РЕГУЛИРОВАНИИ 

 

Давним стремлением человечества было создание  искусственного интел-

лекта.  Интеллектуальность (разумность) человека определяется  наличием ком-

плексной  способности, с помощью которой он распознает объекты, явления и со-

ответственно ситуации адекватно на них реагирует.  

Основными признаками интеллекта являются: 

- адекватное осознание ситуации  при неоднозначной или противоречивой 

информации; 

- нахождение аналогий, способность к классификации; 

- способность к изучению новых понятий и установлению связей между 

разными понятиями, способность к проведению анализа и синтеза. 

Задачей теории искусственного интеллекта, как области прикладной мате-

матики, является  формализация процессов распознавания, обобщения  и позна-

ния, перенос их на язык алгоритмов. При этом умственная деятельность сводится 

к обработке информации. Это означает, что если теория искусственного интел-

лекта исходит из того, что деятельность человеческого ума в определенной мере 

может быть рассмотрена независимо от функций мозга, то достаточно знать ос-

новные принципы умного поведения, чтобы записать их в виде алгоритмов, по-

нятных для компьютера.  

Таким образом, инженерно-научный аспект теории искусственного интел-

лекта состоит в проектировании сложных систем обработки информации [1]. Эта 

задача включает в себя разработку, как методов обработки информации, так и со-

ответствующих устройств и программного обеспечения. 

 Выделяют несколько направлений развития искусственного интеллекта, 

основанного на применении компьютерных технологий [1]: 

- фаззи-логика; 

- экспертные системы; 

- нейросети; 
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- эволюционное моделирование. 

Перед разработчиками искусственного интеллекта стоит цель создания 

компьютерных систем, способных выполнять: 

1) решение сложных многомерных логических задач.  

2) распознавание и понимание человеческой речи; 

3) распознавание и обработка изображений; 

4) обучение системы; 

5) экспертные оценки;  

6) создание качественных выводов.  

 Решение первой, пятой и шестой задач тесно связано с фаззи-логикой. Ан-

глийский термин fuzzy означает нечеткий, размытый и произносится «фаззи».  

Фаззи-логика – это логика нечетких множеств.  

Нечеткая логика является многозначной логикой, что позволяет определить 

промежуточные значения для таких общепринятых оценок, как да|нет, истин-

но|ложно, черное|белое и т.п.  

Теория фаззи-логики позволяет выражения подобные таким, как слегка 

тепло или  довольно холодно,  формулировать математически и обрабатывать на 

компьютерах.  

Понятие нечеткой логики появилось в 1965 г. в работах Лотфи А. Задэ (Lotfi 

A. Zadeh), профессора Калифорнийского университета в Беркли [2].  

 

1.1 Понятие нечетких множеств 

 

Из классической математики известно понятие четких (определенных) 

множеств [3]. Рассмотрим, например, множество А всех чисел от 0 до 10.  

Определим подмножество A0  множества х всех действительных чисел  от 5 

до 7:  А0 = [5,7].   

            График характеристической функции множества A0, в зависимости 

от того, принадлежит данный элемент подмножеству A (что соответствует логи-

ческой 1) или нет (что соответствует логическому 0), представлен на  рисунке 1.1.  
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Рисунок	1.1	–	График	характеристической	функции	μА0		четкого	под‐

множества	А0	

 
Рассмотрим пример нечеткого множества. 

При механической обработке деталей на токарном станке для определенных материалов су-

ществуют оптимальные скорости резания. Пусть  электропривод главного движения станка 

для конкретного материала детали должен обеспечить технологически удовлетворительную 

скорость резания (частоту вращения шпинделя) в диапазоне D = 20…40 об/мин, причем при 

частоте  n0 = 30 об/мин качество обработки – идеальное, а при частотах больших и меньших 

n0 качество в указанном диапазоне  не соответствует идеальному значению, но удовлетво-

рительное. Причем, чем больше отклонение частоты от значения n0, тем хуже качество обра-

ботки. При скоростях обработки, соответствующих частотам вращения шпинделя  менее 20 и 

более 40 об/мин, качество обработки неудовлетворительное, а деталь бракуется. 

Рассмотрим, как с помощью нечеткого множества определить такое выра-

жение, как  удовлетворительные частоты. 

Обозначим нечеткое множество «удовлетворительные частоты» индексом 

N. 

μА0 

х 

1 

5 7
0 
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В первом примере мы кодировали все элементы рассуждения с помощью 0 

или 1. Простой способ обобщить данную концепцию - ввести значения между 0 и 

1. Реально можно даже допустить бесконечное число значений между 0 и 1, назы-

ваемое единичным интервалом I = [0, 1].  
В этом примере нечеткое множество удовлетворительных частот имеет разное отношение к 

качеству обработки детали.  

Идеальная частота n0 дает идеальное качество, имеющее код 1, частоты 20 и 40 об/мин дают 

неудовлетворительное качество обработки, т.е. нулевое (код 0). Промежуточные частоты в 

поддиапазоне 40 > n >  30 об/мин, а также  30 > n > 20 об/мин имеют разные отношения к ка-

честву. 

Зависимость качества  от частоты может быть линейной или нелинейной. 

В первом приближении примем эту зависимость линейной. 

График характеристической функции μN множества N приведен на рисунке 

1.2. 
Таким образом, нечеткое множество – это множество, элементы которого принадлежат к 

нему с разной степенью, которая находится в интервале от 0 до 1. 

Математически нечеткое множество N записывается таким образом: 

N ={ [ μN(n1) ]...[ μN(nn) ] }.                  (1.1) 

Это означает, что величины ni принадлежат к нечеткому множеству N со 

степенью принадлежности μN(ni). Как правило, для идентификации фаззи-

множеств, например A,  используют так называемую функцию принадлежности 

μА(xi). Функции принадлежности могут принимать разнообразные формы, наибо-

лее распространенные из них приведены в таблице 1.1 [1]. 
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Рисунок	1.2	–	График	характеристической	μN	функции	нечеткого	мно‐

жества	N	

 

Аналогично действиям с обычными множествами  при решении задач 

управления требуется определять пересечение (конъюнкцию), объединение 

(дизъюнкцию) и отрицание (инверсию) нечетких множеств [1].  

В своей самой первой работе по нечетким множествам Л. А. Задэ предло-

жил оператор минимума для пересечения и оператор максимума для объеди-

нения двух нечетких множеств. 

Эти операции совпадают с обычными (четкими) объединением и пересече-

нием, только рассматриваются степени принадлежности 0 и 1.  

Логическая операция «И» реализует пересечение фаззи-множеств. 

n 

μN 

1 

0.5 

30 35 40 60 

0 
20 25 
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Таблица 1.1 – Функции принадлежности нечетких множеств[1] 

Тип функции 
Математическое  
определение Графическое  

изображение 
Монотонная 
(линейная) 

⎪
⎩

⎪
⎨

⎧

≤

≤≤
−
−

<

=

xbпри1

b,xaпри
ab
ax

a,xпри0

(x)μA  

 

μ A

xa b

Треугольная 

⎪
⎪
⎪

⎩

⎪⎪
⎪

⎨

⎧

≤≤
−
−

≤≤
−
−

≤∨<

=

dxmпри
dm
dx

m,xaпри
am
ax

x,daxпри0

(x)μA

 

 μA

x a        m      d 

Трапециевид-
ная 

 

⎪
⎪
⎪

⎩

⎪⎪
⎪

⎨

⎧

≤≤
−
−

≤≤

≤≤
−
−

≤∨<

=

dxcпри
dc
dx

c,xbпри1

b,xaпри
ab
ax

x,daxпри0

(x)μA

 

 μA

x a       b         c      d 

Прямоугольная  

⎩
⎨
⎧

≤≤
<∨<

=
bxaпри1

x,baxпри0
(x)μA

 

 μA

x a                b 

Функция  
Гаусса 

 
 

0a
2m)(xae(x)Аμ >−⋅−=  

μA

x m

 
Синглетон-
функция 

 
 

⎩
⎨
⎧

≠
=

=
mxпри0
m,xпри1

(x)μA  

μA

xm
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Пересечение фаззи-множеств A1∩A2 математически с учетом критерия ми-

нимума определяется:  

⎪⎭

⎪
⎬
⎫

⎪⎩

⎪
⎨
⎧

=
∩

 (x)
2Aμ(x),

1Aμmin(x)
2A1Aμ .                                (1.2) 

Логическая операция «ИЛИ» реализует объединение фаззи-множеств. Объ-

единение двух фаззи-множеств A1∪A2 математически с учетом критерия макси-

мума определяется:  

⎪⎭

⎪
⎬
⎫

⎪⎩

⎪
⎨
⎧

=
∪

(x)
2Aμ(x),

1Aμmax(x)
2A1Aμ .                          (1.3) 

Логическая операция «НЕ» реализует логическое отрицание фаззи-

множеств. Логическое отрицание ¬A фаззи-множества A определяется: 

(x)Aμ1(x)Aμ −=
¬

                                 (1.4) 

Логические операции над фаззи-множествами могут быть рассмотрены как 

обобщения классических операций над множествами. На рисунках 1.3, 1.4 приве-

дено графическое изображение представленных выше операций с нечеткими 

множествами.  

 
 
 
 
 
 
 

 
 

а – операция И; б – операция ИЛИ 
Рисунок 1.3 – Графики, иллюстрирующие логические операции с нечеткими   

множествами 

а

μА1∩А2 
 

1 

0 

А1 А2 

х

μА1∩А2 
 

б

μА1∪А2 

1 

0

А1 А2 

х

μА1∪А2 
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В процессе дальнейшего развития фаззи-логики были определены также 

другие операторы для фаззи-множеств [1].  

 

 

 

 

 

 

 

Рисунок 1.4 – График, иллюстрирующий логическую  операцию НЕ с нечет-

ким множеством  А1 

 

 
Рассмотрим применение фаззи-логики на примере управления электроприводом механизма передвижения тележки, на которой уста-

новлен  перевернутый маятник (рисунок 1.5). Нижний конец маятника шарнирно закреплен на тележке, которая может двигаться только в двух 
направлениях: влево или вправо.  
         Задача управления электроприводом передвижения тележки состоит в поддержании перевернутого маятника в вертикальном положении. 

Например, при падении маятника вправо привод должен перемещать тележку вправо и, наоборот, при падении маятника влево при-
вод должен перемещать тележку влево. Система управления должна контролировать угол ϕ  поворота маятника, скорость ω поворота рычага 
(см. рисунок 1.5) и по их соотношениям  выдавать сигнал управления на установку соответствующего знака и значения скорости v тележки. 

 

Рисунок 1.5 – Кинематическая схема перевернутого маятника 
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А1 

х
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Для упрощения предполагается, что начальное положение мачты около 

центра справа, а угол более 450 в любом направлении по условию никогда не 

возникнет.  

Практически эта задача решается системой управления с фаззи-

контроллером, структура которой приведена на рисунке 1.6. 

 
 

 

 

 

 

 

 

 

Рисунок 1.6 – Структура системы управления с фаззи-контроллером 

Контроллеры нечеткой логики - наиболее важное практическое приложение 

теории нечетких множеств. Их функционирование отличается от работы обычных 

контроллеров.  

Для создания алгоритма управления фаззи-контроллера вместо решения 

дифференциальных уравнений используются знания экспертов и логические пра-

вила обработки входных сигналов, представленных нечеткими множествами.  

Знания экспертов могут быть выражены естественным образом с помощью 

лингвистических переменных, которыми описываются нечеткие множества.  

          Процесс фаззификации  основан на создании и идентификации нечетких 

множеств в интервалах варьирования входных и выходных переменных фаззи-

контроллера. Для этого диапазоны изменения входных и выходных переменных 

разбиваются на несколько поддиапазонов, которые представляют нечеткие мно-

жества:  

- в области нуля; 

- в области малых положительных и отрицательных изменений; 

- в области  средних положительных и отрицательных изменений (при 

необходимости); 

- в области больших положительных и отрицательных изменений.  
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Соседние множества должны пересекаться. Тип функций принадлеж-

ности множеств выбирается в соответствии с таблицей 1.1. 

На рисунке 1.7 приведены графики характеристических функций фаз-

зи-множеств линейной скорости μvi . 
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Рисунок 1.7 - Графики характеристических функций фаззи-множеств ли-

нейных скоростей μvi 

 

На рисунке 1.8 приведены графики характеристических функций фаззи-

множеств углов поворота маятника  μϕi. 

 

  
 

Рисунок 1.8 - Графики характеристических функций фаззи-множеств углов 

поворота маятника  μϕi 

 

На рисунке 1.9 приведены графики характеристических функций фаззи-

множеств скоростей поворота маятника  μωi. 
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Рисунок 1.9 - Графики характеристических функций  

фаззи-множеств скоростей поворота маятника  μωi 

 

Логическая обработка информации в фаззи-контроллере производится по 

специальным лингвистическим правилам, устанавливаемым программистом фаз-

зи-контроллера на основе логических рассуждений. 

Например, маятник находится в центре (угол равен нулю) и не поворачива-

ется (угловая скорость равна нулю). Очевидно, что это желаемое положение и ни-

чего предпринимать не надо (линейная скорость равна нулю).  

          Рассмотрим второй случай:  маятник находится в центре, но движется с ма-

лой скоростью в отрицательном направлении. Для удержания  маятника в центре 

необходимо перемещать тележку с малой отрицательной скоростью. 

Рассмотрим третий случай: маятник находится справа, но движется с малой 

скоростью в положительном направлении. Чтобы вернуть маятник в вертикаль-

ное положение, необходимо тележку перемещать с малой положительной линей-

ной скоростью. 

Получаем три правила: 

1 Если угол равен нулю И угловая скорость равна нулю, то линейная ско-

рость должна быть равна нулю. 

2 Если угол равен нулю И угловая скорость равна малой отрицательной, то 

линейная скорость должна быть равна малой отрицательной. 

1 

0 +ω 

ω 0 +ωm +ωb -ωm -ωb 

-ω 

0.6 
0.4 
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3 Если угол малый положительный И угловая скорость равна нулю, то ли-

нейная скорость должна быть равна малой положительной. 

Аналогично устанавливаются другие правила, соответствующие всевоз-

можным совпадениям входных фаззи-можеств. Число этих правил в приведенном 

примере равно числу сочетаний из десяти по два.  

Правила сводятся в таблице 1.2. 

Таблица 1.2 - Пример заполнения таблицы фаззи-правил 

 Углы поворота  

С
ко
ро
ст
и 
по
во
ро
та

  -ϕb -ϕm ϕ0 +ϕm +ϕb 

+ωb v0 v0 +vb +vb +vb 

+ωm v0 v0 +vm +vm +vb 

ω0 -vb -vm v0 +vm +vb 

-ωm -vb -vm -vm v0 v0 

-ωb -vb -vb -vb v0 v0 

 

Задачей создания алгоритма работы фаззи-контроллера по фаззи-правилам 

является  преобразование качественного экспертного знания в закон регулирова-

ния, который может быть реализован технически.  

Входными данными для этого процесса  являются фаззи-правила и степени 

принадлежности, по которым устанавливается определенное логическое высказы-

вание. На основе результатов фаззификации и фаззи-правил в блоке фаззи-правил 

происходит формирование выходного фаззи-множества.  

Процесс обработки нечеткой информации в блоке фаззи-правил можно 

условно поделить на три этапа: 

1) агрегацию; 

2)  импликацию; 

3) аккумуляцию. 
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В процессе агрегации выбираются разные элементарные высказывания, ко-

торые принадлежат к одному фаззи-правилу, и определяется степень принадлеж-

ности к нему. 

Каждая условная часть правила состоит из нескольких элементарных вы-

сказываний, которые с помощью логических связей сводятся к единому ком-

плексному высказыванию.  

Операторами агрегации могут быть любые из приведенных выше операто-

ров, но в технике регулирования используется, как правило лишь И-оператор [1]. 

И-оператор в общем виде может быть реализован по критерию минимума: 

),k(xik,Emin
m

1k
)m(xim,E),...,1(xi1,Emin)x(iE

=
=

⎭
⎬
⎫

⎩
⎨
⎧=                    (1.5) 

где  Еk,i – элементарные высказывания (фаззи-множества). 

Процесс агрегации (принадлежности к первому правилу) для произвольно 

принятых численных значений входных переменных ϕ1 и ω1 поясняется  рисун-

ком 1.10. 

В процессе импликации для каждого активного фаззи-правила в зависимо-

сти от численного значения степени принадлежности определяются  

фаззи-множества Vk.  

Для осуществления импликации используются операторы композиции. Ча-

сто в качестве оператора импликации в технике регулирования используется  И-

оператор Мамдани [1]. Графическое представление импликации с помощью И-

оператора приведено на рисунке 1.11. 
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Рисунок 1.10 – Графики, поясняющие процесс агрегации 

 

 

 

 

 

 

 

 

 

 

Рисунок 1.11 - Графическое представление импликации с помощью  
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И-оператора Мамдани  

Результатом использования правила 2 для реальной угловой скорости ω1 

является импликация (рисунок 1.12). 

 

 

 

 

 

 

 

 

 

Рисунок 1.12 – Импликация в соответствии с фаззи-правилом 2 

 

Результатом использования правила 3 для реальной угловой скорости ω1 

является импликация (рисунок 1.13). 

 

 

 

 

 

 

 

 

                

 

 

Рисунок 1.13 – Импликация в соответствии с фаззи-правилом 3 
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Последним этапом процесса обработки нечеткой информации в блоке  фаз-

зи-правил  является аккумуляция.  

Задачей аккумуляции является объединение результатов  импликации.  

Результатом аккумуляции является фаззи-множество VΣ, которое получается 

путем объединения отдельных фаззи-множеств: V0, -Vm, +Vm . Функция при-

надлежности результирующего фаззи-множества получается с помощью операто-

ра аккумуляции Akk: 

        Vm(v)}.,(v),-Vm(v)V0{Akk
n

1i
(v)Vμ +

=
=                          (1.6) 

Аккумулированное фаззи-множество VΣ представляет собой окончательный 

результат процесса обработки информации в блоке фаззи-правил.   

Таким образом, результатом обработки нечетких множеств углов и угловых 

скоростей по правилам эксперта является нечеткое множество скорости VΣ , пред-

ставленное на рисунке 1.14.  

 

 

 

 

 

 

 

 

 
 

Рисунок 1.14 – График аккумулированного нечеткого множества VΣ  
 

Аккумулированное фаззи-множество VΣ не может быть использовано для 

управления, поэтому необходимо преобразовать его в однозначный управляющий 

сигнал.  

μV 
 

1 

0 +v -v v1

VΣ  
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Это преобразование выполняется в блоке дефаззификации (см. рисунок 1.6). 

 Существует большое количество методов дефаззификации, целью которых 

является определение такой однозначной  величины, которая бы как можно точ-

нее представила аккумулированное фаззи-множество.  

 Наиболее распространен гравитационный метод, который основан на опре-

делении центра веса площади функции принадлежности  (см. рисунок 1.14).  

 Центрирующее значение линейной скорости перемещения тележки для ре-

альных значений ϕ1 и ω1 определится в блоке дефаззификации по алгоритму 

∫
∫ ⋅

=
μ(v)dv
μ(v)dvv

1v .                                            (1.7)  
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2 МОДЕЛИРОВАНИЕ СИСТЕМ ФАЗЗИ-РЕГУЛИРОВАНИЯ С ПОМОЩЬЮ 

ПРОГРАММНОГО ПАКЕТА MATLAB/SIMULINK 

 

Важным этапом разработки систем управления электроприводов с фаззи-

регулятором является их моделирование.  

Многие проектировщики пользуются при моделировании программным па-

кетом Matlab и моделирующей программой Simulink, которая входит в его состав. 

Simulink дает возможность создавать наглядные математические модели систем 

регулирования и исследовать их функционирование. 

Для моделирования фаззи-блоков в программном пакете Matlab/Simulink 

был разработан пакет Fuzzy Logic Toolbox, который представляет набор функций, 

созданных  в среде Matlab. Пакет Fuzzy Logic Toolbox включает в себя средства 

создания и редактирования фаззи-блоков в границах структуры Matlab. Fuzzy 

Logic Toolbox дает возможность создавать фаззи-блоки трех типов [4]: 

-  систему инференции Мамдани (Mamdani’s fuzzy inference method) – фаззи-

блок, входные и выходные функции принадлежности которого могут иметь лю-

бую из приведенных в таблице 1.1 форму); 

-   систему инференции Сугено (Sugeno’s fuzzy inference method) –  

фаззи-блок, входные и выходные функции принадлежности которого могут быть 

лишь постоянными или изменяющимися линейно); 

-   адаптивную нейро-фаззи-систему инференции (adaptive neuro-fuzzy 

inference system) – фаззи-блок, установка параметров функций принадлеж-

ности которого происходит на основе заданных желаемых значений вход-

ных и выходных величин фаззи-блока с помощью методов тренировки 

нейросети. 

В данной работе рассматривается моделирование систем лишь первого ти-

па. 

Созданные с помощью Fuzzy Logic Toolbox фаззи-системы могут быть про-

моделированы программой Simulink. Недостатком Fuzzy Logic Toolbox является 

отсутствие возможности использования в системе инференции Мамдани функций 
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принадлежности с переменными параметрами. Моделировать в Matlab/Simulink 

такой адаптивный фаззи-блок можно, лишь написав функцию пользователя, кото-

рая содержит алгоритм обработки информации в среде Matlab или С, и поместив 

эту функцию Simulink-модели с помощью блока Matlab Fcn (функции Matlab) 

или S-Function (S-функции). 

Средства, которые входят в состав Fuzzy Logic Toolbox, можно поделить на 

две группы. К первой группе относятся редактор фаззи-блоков (FIS Editor), ре-

дактор правил (Rule Editor) и редактор функций принадлежности (Membership 

Function Editor). Эти средства служат для установления входных и выходных пе-

ременных фаззи-блока, их функций принадлежности и фаззи-правил. Вторая 

группа представляет собой read-only Tools, то есть инструменты, которые не раз-

решают вносить изменения в фаззи-систему, а используются только для  

диагностики. К этой группе относятся просмотрщик трехмерной функции 

(Surface Viewer) и просмотрщик правил (Rule Viewer). 

Для того, чтобы вызвать Fuzzy Logic Toolbox, необходимо набрать в ко-

мандной строке Matlab fuzzy и нажать клавишу Enter. После этого открывается 

окно, вид которого представленный на рис. 2.1. 
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Рисунок 2.1 – Редактор фаззи-блоков 

 

В этом окне Вы можете создать собственный фаззи-блок. В том случае, если 

фаззи-блок содержит более чем одну входную или выходную переменные, надо 

выбрать в меню соответственно Edit→Add input или Edit→Add output.  

Чтобы отредактировать функции принадлежности, надо щелкнуть дважды 

левой клавишей мыши на иконке входной или выходной переменной или выбрать 

в меню View→Edit Membershipsfunctions.  

После этого на экране появится окно редактора функций принадлежности 

(рис. 2.2), с помощью которого можно задать функции принадлежности опреде-

ленной лингвистической переменной или отредактировать уже существующие. 

 

 Это меню используется для 
создания, открытия, 
сохранения и редактирования 
фаззи-блоков 

Здесь можно 
просмотреть имя и тип 
фаззи-блока (Mamdani 
или Sugeno) 

С помощью этого 
меню Вы можете 
установить 
операторы 
инференции и метод 
дефаззификации 

Щелкните дважды здесь левой 
клавишей мыши, чтобы 
отредактировать фаззи-правила Это поле служит для 

введения и 
редактирования имен 
входных и выходных 
фаззи-множеств 

Щелкните здесь дважды левой клавишей мыши, чтобы 
отредактировать входную (input) или выходную (output) 
 функции принадлежности  
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Щелкните дважды левой
клавишей мыши на
иконке определенной
переменной, чтобы
отредактировать ее
параметры

Это поле показывает все функции
принадлежности активной входной или
выходной переменной

Щелкните левой клавишей
мыши на кривой, чтобы
иметь возможность
изменить ее свойства (имя,
тип,  числовые параметры)

Здесь Вы можете
изменить имя
активной функции
принадлежности

Установка типа
активной функции
принадлежности

Числовые параметры
активной функции
принадлежности

Это поле показывает имя
и тип активного фаззи-
множества

Область изменения
активной переменной

Область изменения
активной переменной,
которая отображается на
экране

 
 

 

Рисунок 2.2 – Окно редактора функций принадлежности 
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Для того, чтобы ввести новую функцию принадлежности, необходимо вы-

брать в меню Edit→Add MFs... или Edit→Add custom MFs.... В первом случае 

открывается окно (рисунок 2.3): 

 

 
 

Рисунок 2.3 – Окно параметров стандартной функции 

принадлежности 

 

Во втором случае открывается окно (рисунок 2.4): 

 

 
 

Рисунок 2.4 – Окно параметров функции принадлежности 

 пользователя 

 

В этом окне можно ввести любое имя , тип и границы функции принадлеж-

ности. 

Для введения фаззи-правил используется редактор правил. Чтобы его от-

крыть, надо выбрать в меню View→Edit rules. После этого открывается окно (ри-

сунок 2.5). Складывание фаззи-правил проводится автоматически на основе опи-

сания входных и выходных лингвистических переменных, которое было сделано с 
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помощью редактора фаззи-блоков. Для того, чтобы образовать новое правило, 

надо нажать на кнопку Add rule, после чего выбрать значение каждой входной 

переменной, логическую связь между входными переменными и значение выход-

ной переменной. В случае, если правило не содержит какой-то входной величины, 

надо избрать как входную величину none. Если переменная должна быть проин-

вертирована, надо поставить флажок напротив not. 

 

 

 

Рисунок 2.5 – Окно введения фаззи-правил 

 
Это меню 
используется для 
создания, открытия, 
сохранения и 
редактирования 
 фаззи-блоков 

Выбор имен входных и
выходных функций принадлежноти 

В это поле 
автоматически 
вводятся 
фаззи-правила 

Установка 
логических 
связей между  
переменными 

Инвертирование фаззи-
множеств 

Кнопки  ввода, редактирования и 
удаления фаззи-правил 
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Диагностика разработанного фаззи-блока осуществляется с помощью про-

смотрщика трехмерной функции (Surface Viewer) и просмотрщика правил (Rule 

Viewer). Для того, чтобы вызвать окно просмотрщика правил, надо избрать в ме-

ню View→View rules, после чего на экране появится окно (рисунок 2.6): 

 

 

Рисунок 2.6 – Окно тестирования фаззи-правил 

 

Просмотрщик правил дает возможность для любой комбинации числовых 

значений входных переменных определить соответствующее числовое значение 

выходной переменной. 

Просмотрщик трехмерной функции дает возможность представить зависи-

мость выходной переменной от входных в виде трехмерного графика.  Это разре-

шает проанализировать работу фаззи-блоков, которые имеют две входные и одну 

выходную переменную. В случае, если фаззи-блок имеет более чем одну выход-

 
 

Результат
дефаззификаци

Каждый столбик графиков показывает, как входная или выходная 
переменная используется в правиле. Сверху показывается имя 
переменной и ее текущее числовое значение 

Каждая строка 
графически 
представляет фаззи-
правило 

В этом поле Вы 
можете точно ввести 
числовые значения 
входных величин 
 

Передвигая эти линии, можно приблизительно установить 
числовые значения входных переменных, для которых 
будет рассчитанно значение выходной переменной 

Эти кнопки разрешают передвинуть 
графики влево, вправо, вниз, вверх 
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ную переменную или более чем две входные переменные можно избрать такую 

комбинацию двух входных и одной выходной переменной, которая разрешает 

наилучшим образом представить передающие свойства фаззи-блока. Для того, 

чтобы вызвать просмотрщик трехмерной функции, необходимо избрать в меню 

View команду View surface, после чего на экране появится окно (рисунок 2.7): 

 

Используйте мышь,
чтобы повернуть оси

В этих полях выбираются имена
переменных, которые должны
быть представлены на графике

Нажмите здесь в
случае
необходимости
б ф

Область представления трехмерного
график зависимости выходной
величины от избранных входных
величин

Это меню используется для создания,
открытия, редактирования и сохранения
фаззи-блоков

В этом поле
показываются имена
переменных, которые
не отображаются на
трехмерном графике

 
Рисунок 2.7 – Окно просмотрщика  трехмерного графика, передающего   функ-

ции фаззи-блока 

 

Для  просмотра  установки фаззи-блока в более удобной форме, с возмож-

ностью копирования информации в буфер обмена данных для дальнейшего ре-

дактирования с помощью других программ, был разработан ряд функций вывода 

на экран (System Display Functions).  

Обзор этих функций представлен в таблице 2.1. 
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Таблица 2.1 – Функции вывода  установок фаззи-блока на экран 

Имя и параметры  

функции 

Описание функций 

plotfis (fismat) Создает в окне  диаграмму фаззи-

блока, который помещается в рабочем про-

странстве Matlab под именем fismat. На 

диаграмме показываются входные и выход-

ные переменные, их вид, количество фаззи-

правил и тип системы инференции 

plotmf 

(fismat,varType,varIndex) 

Выводит на экран график функции 

принадлежности лингвистической пере-

менной фаззи-блока fismat. В списке пара-

метров указываются тип переменной (Input 

или Output) и ее индекс 

gensurf (fismat) Выводит на экран трехмерный график 

передающей функции фаззи-блока fismat 

getfis (fismat) Выводит на экран установки фаззи-

блока fismat – тип фаззи-блока, количество 

входных и выходных переменных, их име-

на, тип дефаззификации, тип операторов 

инференции 

 
Для подключения разработанного фаззи-блока в Simulink-модель, которая 

содержит фаззи-регулятор, и моделирования этой системы регулирования, надо 

сначала убедиться, что фаззи-блок, созданный с помощью редактора фаззи-

блоков,  сохранен в рабочем пространстве Matlab под именем, которое использу-

ется при параметризации Simulink-блока Fuzzy-Logic-Controller 

Для  сохранения параметров созданного фаззи-блока в рабочем простран-

стве Matlab надо избрать в меню редактора фаззи-блоков File, включить команды 

Save to workspace и Save to workspace as. В случае, если фаззи-блок был  спроек-
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тирован и сохранен на жестком диске или другом элементе памяти раньше, эту 

операцию можно выполнить непосредственно в рабочем пространстве Matlab. 

Для этого в командной строке Matlab необходимо набрать команду: fuz = 

readfis('Controller'), где  fuz – имя FIS-матрицы, которая отображает фаззи-блок в 

рабочем пространстве  Matlab; 

Controller - имя файла разработанного фаззи-блока. 

После этого надо открыть Simulink-библиотеку fuzblock. В результате от-

крывается окно (рисунок 2.8): 

 

 

 
 

Рисунок 2.8 – Simulink-библиотека фаззи-блоков 
 

 

Из этой библиотеки в Simulink-модель методом «перетаскивания» копиру-

ется один из таких блоков: 

- Fuzzy Logic Controller; 

- Fuzzy Controller with ruleviewer. 

Использование блока Fuzzy Controller with ruleviewer дает возможность в 

процессе моделирования наблюдать за изменениями входных и выходных вели-

чин фаззи-блока с помощью просмотрщика правил. 

Избранный блок необходимо идентифицировать. Для этого надо дважды 

щелкнуть левой клавишей мыши на иконке блока на поле Simulink – модели сис-
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темы управления. Если используется блок Fuzzy Logic Controller, то после этого 

на экране появится окно (рисунок 2.9): 

 

Имя фаззи-блока,
который Вы
используете в модели
(имя FIS-матрицы,
которая представляет
его в среде Matlab)

 
 

Рисунок 2.9 – Окно параметров блока Fuzzy Logic Controller 

 

Блок Fuzzy Controller with ruleviewer имеет довольно сложную структуру, 

которая представлена на рисунке 2.10. 

 

 

 

 

 

 

Имя фаззи-блока в
рабочем
пространстве Matlab

 
 

Рисунок 2.10 – Структура блока Fuzzy Controller with ruleviewer 
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Параметризация блока Fuzzy Controller with ruleviewer осуществляется, 

как показано на рисунке 2.10. 

 

 

3 СИСТЕМА УПРАВЛЕНИЯ СЛЕДЯЩИМ 

ЭЛЕКТРОПРИВОДОМ  (СЭП) С ФАЗЗИ-КОНТРОЛЛЕРОМ 

 

Система управления СЭП должна обеспечивать заданную точность регули-

рования положения рабочего органа без перерегулирования. 

Функциональная схема трехконтурной САР СЭП [5] приведена на рисунке 

3.1. 

 

 

Функциональная схема включает: 

- силовой трансформатор ТV; 
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- тиристорный преобразователь ТП; 

- электродвигатель постоянного тока Д; 

- регулятор тока РТ; 

- регулятор скорости РС; 

- регулятор положения РП; 

- датчик тока ДТ; 

- датчик скорости ДС; 

- датчик положения ДП; 

- узел зависимого токоограничения УЗТ; 

- блок ограничения минимального угла управления БО; 

- блок защит БЗ. 

РП 
uЗП 

uРП uРС 
Ud, IЯ ω 

ТV 

FU1‐3

~ 3 50 Гц

Д ТП 

БЗ 

-uc 

ДС 

РТ РС 

ДТ 

УЗТ 

ДП 

-uП -uТ 

uРТ 

БО 

ω 

φ 

iЯ 

Рисунок 3.1 - Функциональная схема системы  регулирования положения 
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Структурная схема системы регулирования положения,  разработанная на 

основе функциональной схемы, приведена на рисунке 3.2.  

 

На рисунке 3.3 в качестве примера приведена структурная схема модели 

следящего электропривода в MatLаb Simulink. 

Рисунок 3.2 - Структурная схема системы регулирования положения 
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φ WДП (s) 

uРТ 
(s)

WУЗТ(s) 
ω 

-uДТ (s) -uДП 

М (s) 



36 
 

 

В зависимости от значений коэффициентов передачи САР по прямому ка-

налу управления график переходного процесса изменения угла поворота ϕ(t) мо-

жет иметь разный вид. 

Время регулирования СЭП зависит от статического коэффициента передачи 

регулятора положения. Увеличить быстродействие системы можно за счет его 

увеличения. 

В качестве иллюстрации на рисунке 3.4  приведены графики  переходного 

процесса i(t), ω(t), ϕ(t)  для  исходного (увеличенного) значения коэффициента 

передачи регулятора положения. 

На рисунке 3.4 видно, что имеет место перерегулирование основной коор-

динаты – положения, это недопустимо для систем регулирования положения. 

 

Рисунок 3.3 – Схема структурной модели  СЭП в MatLab Simulink 
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На рисунке 3.5 приведены графики  переходного процесса i(t), ω(t), ϕ(t)  по-

сле коррекции коэффициента передачи регулятора положения (kп = 0.04). 

Переходный процесс ϕ(t)  на рисунке 3.5 показывает, что при малых коэф-

фициентах передачи регулятора положения перерегулирование отсутствует, но 

время регулирования достигает 25 с. При больших коэффициентах передачи регу-

лятора положения время первого установления задания уменьшается  в несколько 

раз, но возникает перерегулирование, которое недопустимо (см. рисунок 3.4).  

Идея применения фаззи-контроллера состоит в ускорении времени регули-

рования СЭП. 

Задачей, которую должен решать фаззи-контроллер, является  исключение 

динамической ошибки регулирования при обеспечении  заданного быстродей-

ствия.  

Рисунок 3.4 – Графики переходных функций i(t), ω(t), ϕ(t) исходной си-

стемы управления СЭП 

ϕ(t)   

 ω(t)  i(t) 

t, c 

t1 



38 
 

При этом фаззи-контроллер должен обеспечивать время регулирования, 

равное времени t1 первого достижения системой управления задания  ϕз (см. ри-

сунок 3.4). 

Целью параллельной коррекции с помощью фаззи-контроллера является 

получение заданной переходной функции ϕз(t), общий вид которой приведен на 

рисунке 3.6. 

 

 

 

 

 

 

 

 

 

 

 

ϕ(t)   

 ω(t)  i(t) 

t, c 

Рисунок 3.5 – Графики переходных функций i(t), ω(t), ϕ(t) СУЭП после 

коррекции kп

t1

ϕ(t)

Рисунок 3.6 – График желаемого переходного процесса ϕз(t) СУЭП  

после фаззи-коррекции 

t1 

t, c 
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Подключение фаззи-контроллера в режиме параллельной коррекции регу-

лятора положения показано на рисунке 3.7. 

 

 

Рисунок 3.7 – Схема модели СЭП с фаззи-коррекцией регулятора положения 


